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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
ATA6847 QFN40 BLDC Motor Driver Evaluation Board. Items discussed in this chapter 
include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the ATA6847 QFN40 BLDC Motor Driver 
Evaluation Board. The manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the ATA6847 
QFN40 BLDC Motor Driver Evaluation Board. 

• Chapter 2. “Installation and Operation” – Includes instructions on installing and 
using the ATA6847 QFN40 BLDC Motor Driver Evaluation Board.

• Appendix A. “Schematics and Layouts” – Shows the schematic and layout
diagrams for the ATA6847 QFN40 BLDC Motor Driver Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
ATA6847 QFN40 BLDC Motor Driver Evaluation Board.

• Appendix C. “Software” – Provides information about the demo application and 
where the source code can be found.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50003756B-page 6  2024 Microchip Technology Inc. and its subsidiaries
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RECOMMENDED READING

This user's guide describes how to use the ATA6847 QFN40 BLDC Motor Driver 
Evaluation Board. Other useful documents are listed below. The following Microchip 
documents are available and recommended as supplemental reference resources:

• ATA6847 Data Sheet - “Three-Phase Brushless Motor Gate Driver SBC” 
(DS20006940) – This data sheet provides detailed information regarding the 
ATA6847 product family.

• dsPIC33EPXXXGP50X, dsPIC33EPXXXMC20X/50X and 
PIC24EPXXXGP/MC20X Data Sheet - “16-Bit Microcontrollers and Digital 
Signal Controllers with High-Speed PWM, Op Amps and Advanced Analog” 
(DS70000657) – This data sheet provides detailed information regarding the 
dsPIC33CK128MP503 product family.

• dsPIC33/PIC24 Family Reference Manual (DS70573)

• dsPIC33EPXXXGP50X, dsPIC33EPXXXMC20X/50X, and 
PIC24EPXXXGP/MC20X - “Family Silicon Errata and Data Sheet 
Clarification” (DS80000533) – This data sheet contains anomalies and 
clarifications for the dsPIC33EPXXXMC504 processor.

• AN1078 - “Sensorless Field Oriented Control of a PMSM” (DS01078)

• AN1160 - “Sensorless BLDC Control with Back-EMF Filtering Using a 
Majority Function” (DS01160)

• AN992 - “Sensorless BLDC Motor Control Using dsPIC30F2010” (DS00992)

• AN1292 - “Sensorless Field Oriented Control (FOC) for a Permanent Magnet 
Synchronous Motor (PMSM) Using a PLL Estimator and Field Weakening 
(FW)” (DS01292)

• AN901 - “Using the dsPIC30F for Sensorless BLDC Control” (DS00901)

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 7
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip's customer notification service helps keep customers current on Microchip 
products. Subscribers will receive an e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers - The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB® C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators - The latest information on Microchip in-circuit emulators.This includes 
the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers - The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3/4 
Debug Express.

• MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers - The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and PICkit 
2, 3 and 4 programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
https://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision B (November 2024)

• Updated BLDC motor current values.

• Replaced Figure 1-1: “ATA6847 QFN40 BLDC Motor Driver Evaluation Board 
Block Diagram.”

Revision A (October 2024)

• Initial release of this document.
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Chapter 1.  Product Overview
1.1 INTRODUCTION

This chapter covers the following topics:

• ATA6847 QFN40 BLDC Motor Driver Evaluation Board Overview

• What is the ATA6847 QFN40 BLDC Motor Driver Evaluation Board?

• What does the ATA6847 QFN40 BLDC Motor Driver Evaluation Board Kit 
Include?

1.2 ATA6847 QFN40 BLDC MOTOR DRIVER EVALUATION BOARD OVERVIEW
The ATA6847 QFN40 BLDC Motor Driver Evaluation Board is used to demonstrate the 
driver capabilities offered by the ATA6847-3333 and -5033 in BLDC/PMSM motor 
applications.

The two-layered, high current board is designed to be very versatile, low cost, and 
easily configurable to meet as many customer preferences as possible. It uses the 
ATA6847 QFN40 as a 3-phase Brushless DC (BLDC) motor gate driver and the 
dsPIC33CK64MP205T digital signal microcontroller provided by Microchip. In order to 
implement different types of algorithms, like the sinusoidal three shunt FOC or the 
trapezoidal motor control algorithm in sensored or sensorless mode, the board can be 
easily configured by using the jumpers and connectors located on the board. 
Furthermore, the desired firmware should be implemented accordingly to the desired 
hardware configuration.

As provided, the ATA6847 QFN40 BLDC Motor Driver Evaluation Board is ready to 
drive a BLDC motor using the FOC method in sensorless mode. The board is equipped 
with a Start/Stop button and a potentiometer that can be used to adjust the speed of the 
motor. The evaluation board can drive a BLDC motor with a supply voltage of up to 
32.5V and a motor current up to 35A RMS. For higher load currents a custom heat sink 
can be attached on the bottom side. The ATA6847 QFN40 BLDC Motor Driver 
Evaluation Board provides 3.3V/5V/100 mA LDOs, a 3.3V buck regulator, a USB serial 
connection, three current sense operational amplifiers (one inside the ATA6847 and 
two inside the dsPIC33), a Back EMF detector and Hall-effect sensors inputs. 
Moreover, the ATA6847 has many configuration capabilities for OCP/Limit, 
overvoltage, undervoltage, overtemperature protections due to its internal dedicated 
registers that are available via its SPI interface.

Several test points are available on the board in order to facilitate the user's 
measurements, tuning or motor control optimization.

The evaluation board provides several optical indicators, such as RunLED and FltLED 
for the status indication, PwLED for voltage presence, RX and TX to indicate the serial 
connection to computer.
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 9
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1.3 WHAT IS THE ATA6847 QFN40 BLDC MOTOR DRIVER EVALUATION 
BOARD?

The ATA6847 QFN40 BLDC Motor Driver Evaluation Board is a complete motor 
controller for brushless DC motors (BLDC). The board can drive a three-phase 
brushless DC motor rated at up to 35A and 32.5V. The input voltage motor operating 
range for the board is +4.9V to +32.5V. The board consists of five main units:

• ATA6847 Motor Driver

• DSPIC33CK64MP205T Digital Signal MCU

• Three phase MOSFET Bridge

• USB-UART

• Buck Converter

FIGURE 1-1: ATA6847 QFN40 BLDC Motor Driver Evaluation Board Block 
Diagram.

The on-board ATA6847 generates 3.3V using internal voltage regulators (VDD2) for the 
attached host microcontroller and 5V(VDD1) for the Hall sensors. The ATA6847 also 
contains two charge pumps for low and high side of the Gate Driver Unit to allow 
operation up to 100% duty cycle.

An input terminal block connector is provided to apply the input voltage to the board 
and another output connector is provided to attach the BLDC. 

A programming header connector is available for programming/updating the 
DSPIC33CK64MP205T firmware using a PICkit programmer/debugger.

An input terminal block is supplied on the board, to allow users to connect the Hall 
sensors with selectable voltage supply (5V/3V3).

Four push buttons (RST, Spare, ON/OFF and WakeUp) are available for different 
events generation (start, stop, direction change, reset, etc). The motor speed can be 
adjusted using the available on board reference speed potentiometer.

An optional spare buck power supply is available for ATA6847-3333, which has an INH 
signal for external source activation or for external interfaces if the required current 
exceeds the device capability.

Finally, the PCB layout design can serve as a reference example for a robust, low-cost, 
two-layered, low-voltage, high-current board.

GATE 
DRIVER

ATA6847

dsPIC33
CK64MP

205T

MOSFET 
BRIDGE

BLDC

Hall 
Sensors

VDD

GUI
Commands

MCP2221
USB - UART

MCP16331
Buck

Converter

4.9 to 32.5V
3.

3V

SPI

PWM

FAULT

High Side

Phases

Low Side

iSense

U
SB
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1.4 WHAT DOES THE ATA6847 QFN40 BLDC MOTOR DRIVER EVALUATION 
BOARD KIT INCLUDE?

The ATA6847 QFN40 BLDC Motor Driver Evaluation Board kit includes:

• The ATA6847 QFN40 BLDC Motor Driver Evaluation Board (EV43F54A).

• Key Information Sheet.
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 11
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Chapter 2.  Installation and Operation
2.1 INTRODUCTION
The ATA6847 QFN40 BLDC Motor Driver Evaluation Board demonstrates the features 
of Microchip's 3-Phase Brushless DC (BLDC) Motor Driver with Power Module, 
ATA6847, used in a BLDC motor driver application. When used in conjunction with a 
microcontroller, the ATA6847 will provide the necessary drive signals to drive a 
3-Phase BLDC motor.

The ATA6847 contains all necessary functional blocks for developing high performance 
BLDC/PMSM motor drivers: high and low-side MOSFET drivers, two gain/offset 
configurable Op Amps, protection circuity, Back EMF detector and SPI interface for the 
configuration of the internal registers. 

The board is equipped with the dsPIC33CK64MP205T high performance Digital Signal 
Controller (DSC) and can handle simple motor control algorithms, such as 6-step 
trapezoidal, or high-performance algorithms, such as the Field Oriented Control (FOC). 
The dsPIC (DSC) provides the PWM inputs to the ATA6847; it also handles the high 
speed Analog-to-Digital Conversion (ADC) supporting up to 50 kHz PWM operation for 
the FOC motor control technique or higher for trapezoidal. The microcontroller supports 
a large range of motor control applications due to its specific synchronization between 
different peripherals.

The motor current can be measured using the dual or single-shunt techniques 
described in AN1078. A high-performance current sense amplifier is implemented 
using one of the ATA6847 internal Op Amps. The second internal Op Amp can be 
configured either as B-EMF or current sense amplifier. Two additional Op Amps are 
used from the dsPIC33CK64MP205T.

2.2 FEATURES
The ATA6847 QFN40 BLDC Motor Driver Evaluation Board has the following features:

• Input operating voltage range: 4.9V to 32.5V
• Maximum of 10/27Ω of gate drive sink/source resistance for external N-Channel 

MOSFETs and programmable LS/HS slew rate control: 12.5%, 25%, 50%, 100%
• Drives up to a 35A RMS BLDC motor

• Two programmable gain/offset current sense amplifiers

• ON/OFF push button (RUN)
• Reset push button (RST)
• Spare user-programmable push button (µC/Wk)
• PWM signal LED indicators
• Fault signal LED indicator

• Wake-up push button

• PICkit debugger interface
• Speed control potentiometer
• Terminal block for 3.3V and 5V Hall-effect sensors
• UVLO, OVLO and DUVLO protections
• Programmable external MOSFET short circuit protection 125 mV to 1.75V
• Programmable PWM dead-time protection 100 ns to 6.3 µs (100 ns step)
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 13
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• Thermal shutdown protection

• Programmable timing filters for current and voltages

• Complete “C” source code (provided on the Motor Driver Evaluation Board 
webpage).

2.3 GETTING STARTED

The ATA6847 QFN40 BLDC Motor Driver Evaluation Board is fully assembled and 
tested for driving a BLDC motor. The board can be easily configured to drive a BLDC 
motor in sensored or sensorless mode, as well as for sinusoidal single shunt FOC or 
trapezoidal motor control algorithm.

The board requires the use of an external voltage source capable of supplying 4.9V to 
32.5V at the rated motor current. The board is presented in Figures 2-1 and 2-2. The 
24V, 3-phase, AC300022 BLDC Motor is also required to evaluate the motor driver.

FIGURE 2-1: ATA6847 QFN40 BLDC Motor Driver Evaluation Board PCB (Top).
DS50003756B-page 14  2024 Microchip Technology Inc. and its subsidiaries
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FIGURE 2-2: ATA6847 QFN40 BLDC Motor Driver Evaluation Board PCB (Bottom).

2.3.1 Connections

2.3.1.1 JUMPER SETTINGS

The ATA6847 QFN40 BLDC Motor Driver Evaluation Board has several 
user-configurable jumpers. The jumpers are described in Table 2-1 below. The 
configuration jumpers positioning is illustrated in Figure 2-3:

TABLE 2-1: ATA6847 QFN40 BLDC MOTOR DRIVER EVALUATION BOARD JUMPERS

Jumper Positions Function Description

JpRst1 On/Off Connect/Disconnect MCLR and nRST signals (for WDT operation)

R6.a/R6.b 3.3V/5V 3.3V/5V Hall power voltage supply selection

R4.a/R4.b VDD2/INH Route VDD2 to DSP PwS or INH to Auxiliary Buck (ATA6847-3333). 
Do not place the jumper if powered from the buck.

R54 SMD Resistor 0Ω Populate if Auxiliary Buck is used.
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 15
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FIGURE 2-3: ATA6847 QFN40 BLDC Motor Driver Evaluation Board Jumpers Positioning.

FIGURE 2-4: ATA6847 QFN40 BLDC Motor Driver Evaluation Board Features.

The board can be easily configured for different types of motor and control algorithms:

• BLDC Trapezoidal sensorless based on B-EMF null cross detection

• BLDC Trapezoidal based on sensor position detection

• PMSM, FOC, three shunt sensorless (with/without wind milling)

• PMSM, FOC, three shunt based on sensor position detection.

Speed
Potentiometer

Start button

micro
USB

Programming 
Interface

dsPIC33CK64MP205T Sensor 3.3/5V 

Sensor 
connector

VDD2 / INH
select

Local 
Wake-up

3.3V buck 
output

Test 
Points

BLDC
Phases

Power 
in

Reverse polarity protectionSerial interface
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Table 2-2 describes the jumpers’ settings, for different motor control modes.

For the same motor, Figure 2-5 shows the currents for sensorless trapezoidal and 
sensorless sinusoidal modes, taken on this board.

FIGURE 2-5: Trapezoidal and Sinusoidal Motor Control Modes.

Pressing the Sw1 push button wakes the system up.

Pressing the ST3 push button forces a host controller reset.

R4 is dedicated for the VDD2/INH pin and, when the board is equipped with 
ATA6847-3333, must be put in INH (R4.b) position, to be used as external power sup-
ply activator (the second LDO is not available for this variant). At the same time, R54 
(0Ω) has to be populated to tie the external power supply output to +3.3V line, in order 
to supply the dsPIC33CK microcontroller.

The INH jumper should be skipped if R51 - Enable PullUp is present on the board.

FIGURE 2-6: Evaluation Board Power Supply Diagram.

TABLE 2-2: HARDWARE MOTOR CONTROL MODE SETUP

Jumper Positions  Description

Trapezoidal Sensored Mode

R6.a
or

R6.b

HALL 3.3V

HALL 5V

Route 3.3V to power Hall sensors

Route 5V to power Hall sensors

FOC Sinusoidal Sensored Mode

R6.a
or

R6.b

HALL 3.3V

HALL 5V

Route 3.3V to power Hall sensors

Route 5V to power Hall sensors

ATA6847

LDO
VDD2

LDO
VDD1

Buck EN
R54

R51

4.9 .. 32.5V

R4. a/b

dsPIC33CK64MP
205T

3.3V3.3V
0ohm 100k

Mosfet 
Bridge

4
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2.3.1.2 AVAILABLE INTERFACING CONNECTORS

Five connectors are available, as follows:

• J5 is dedicated for microcontroller programming/debugging. After programming, it 
can be used for other purposes, e.g. for rotary encoder interfacing due to the 
microcontroller pin remapping feature.

• J3 is a simple header connector that can be used for serial communication, using 
a PICkit serial communication tool or a USB-to-serial bridge (e.g. ADM00559 
provided by Microchip).

• JM is the motor driver output. This is the connection to the BLDC motor.

• J1 is the power supply connection. The board needs to be connected to a power 
supply with an output range of 4.9 to 32.5V, according to the voltage ratings of the 
motor utilized by the user.

• J6 connects the Hall effect sensors to the dsPIC33CK64MP205T microcontroller. 
Before connecting the Hall effect sensors, the user must make sure that the Hall 
effect sensors are powered with the right voltage by putting the R6 0R resistor in 
the R6.a location for 3.3V or in the R6.b location for 5V.

Interface Connectors

• J1 (VPwS) input power supply connector.

• JM (MOTOR) three phases output connector.

• J3 (Serial Interface) UART Serial interface.

• J5 (PICKITProg) is mainly dedicated for microcontroller programming/debugging.

Pin Name Description 

1 GND Power Supply Ground

2 VPwS +Power Supply Voltage

Pin Name Description 

1 A Motor A phase

2 B Motor B phase

3 C Motor C phase

Pin Name Description 

1 RxExt UART Output (from USB to MCU)

2 +3.3V 3.3V Output

3 GND Serial Interface GND

4 — —

5 — —

6 TxExt UART Input (from MCU to USB)

Pin Name Description 

1 MCLR Microcontroller reset

2 VPP +3.3V Power-programming

3 VSS Microcontroller GND

4 PGD Programming Data

5 PGC Programming Clock

6 Aux Not used
DS50003756B-page 18  2024 Microchip Technology Inc. and its subsidiaries



Installation and Operation
• J6 (Sensors) Hall sensors interfacing connector. Could be used also for other 
interfacing sensors, e.g. QEI).

2.3.1.3 POWERING THE ATA6847 QFN40 BLDC MOTOR DRIVER EVALUATION 
BOARD

• Apply the input voltage to the input power terminal block, PwS, with respect to 
polarity. The input voltage source should be limited to +32.5V. For proper opera-
tion with a common motor, the input voltage should be between +4.9V and 
+32.5V, in concordance with the motor rated voltage. Connect the positive side of 
the input power source (+) to pin 2 of PwS. Connect the negative or return side (-) 
of the input source to pin 1 of PwS. Refer to Figure 2-3.

2.3.1.4 CONNECTING A MOTOR TO THE ATA6847 QFN40 BLDC MOTOR 
DRIVER EVALUATION BOARD

• Connect each phase winding of a three-phase BLDC motor to the appropriate ter-
minal of the motor terminals (PhA, PhB, PhC).

2.3.2 Operating a Motor

1. Turn the SPEED adjust potentiometer (RV1) fully counterclockwise to obtain the 
slowest speed setting. Now turn the speed adjust approximately ¼ turn clock-
wise to allow for 25% motor speed.

2. Turn on the power supply. At this moment, the red Fault LED is blinking at around 
10 Hz.

3. Press and release the RUN push button (ST1) to start the motor. The motor is 
getting powered. 

4. Turn the Speed potentiometer clockwise to increase motor speed and counter-
clockwise to decrease motor speed. The Speed Adjust changes the PWM duty 
cycle of the PWM signals being sent to the ATA6847.

5. Press and release the RUN push button again to stop the motor.

2.3.3 Indicator LEDs

The ATA6847 QFN40 BLDC Motor Driver Evaluation Board has six LEDs to indicate 
system status. Table 2-3 lists the LED indicators and their description.

Pin Name Description 

1 VH+ Hall power supply +3.3/5V

2 HallC HallC sensor output

3 HallB HallB sensor output

4 HallA HallA sensor output

5 Temp External temperature sensor input

6 VH- Hall GND

TABLE 2-3: LED INDICATORS

PCB Location Name Description

D8 VPw Indicates power supply presence.

D21 Run Motor running state.

D20 Flt Fault FAULT status.

D22 LH
Optical indicator for Limp Home, VDD independent high voltage 
failure output.

D26 RX Data activity received by MCP2221A on RX line.

D27 TX Data activity transmitted by MCP2221A on TX line.
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2.3.4 Test Points

There are several test points on the board that allow probing of voltages, currents and 
signals (see Table 2-4).

2.3.5 Reprogramming the dsPIC33CK64MP205T 100 MHz 
High-Performance DSC

The dsPIC33CK64MP205T 100 MHz High-Performance DSC can be reprogrammed 
with the user's desired firmware. The processor may be programmed by using an exter-
nal power source and a PICkit 3, MPLAB® REAL ICE™ in-circuit emulator, PICkit 4 or 
PICkit 5 programmer.

1. Connect the power source to the board, as explained in Section 2.3.1.3.

2. Connect a PICkit 3, PICkit 4, or PICkit 5 to the J5 header.

3. Start up the MPLABX Integrated Development Environment (IDE) and load the 
EV43F54A_ck_205.X Motor Driver Evaluation Board firmware project. 
In the “ATA6847.h” file, configure the desired application parameters.

4. In the “UserParms.h” file, the desired motor parameters can be configured (see 
Appendix C. “Software”).

5. Build the project.

6. Program the device.

7. Press the RESET switch on the board to reset the processor and allow it to exe-
cute the new firmware program.

TABLE 2-4: TEST POINTS DESCRIPTION

Test Point Name Description

+4.9…32.5V Motor Power supply (+)

GND Power supply ground (-)

3V3 3.3V LDO/Buck output voltage

VDD1 5V internal LDO output

VG12 12V internal low side LDO output

CPP1 Charge Pump 1 Positive Clamp

CPP2 Charge Pump 2 Positive Clamp

MOSI SPI Host Output Client Input

MISO SPI Host Input Client Output

SCK SPI Serial Clock

NCS SPI Chip Select

IRQ Interrupt request

IL1...3 PWMs Low side driver inputs

IH1...3 PWMs High side driver inputs

GL1...3 A/B/C Phase Low side driver outputs

GH1...3 A/B/C Phase High side driver outputs

SH1...3 A/B/C Motor/driver phase signals

RST ATA6847 Reset to Host

LH ATA6847 Limp Home 

IO1_IA OpAmp1 output (current through phase 1)

IO2_IB OpAmp2 output (current through phase 2)

IO3_IBus OpAmp3 output (current through phases)
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2.3.6 Configuring the ATA6847

The ATA6847 has configuration registers that may be used to modify the operating 
parameters of the device. The parameters are modified by sending commands to the 
ATA6847 using the SPI communication interface. Bit sampling is performed on the fall-
ing edge of the clock and data is shifted in/out on the rising edge, as illustrated in 
Figure 2-7. 16 bits must be transmitted to the device for a single register write opera-
tion. The first byte contains the 7-bit address along with a 'read/write' bit (the LSB). The 
second byte contains the data to be written to the register. If the R/W bit is 0, it is a write 
operation, otherwise a read one.

FIGURE 2-7: SPI Timing Protocol.

The user may add code to the evaluation board firmware to communicate with the 
registers. The evaluation board software contains a subroutine which initializes the 
ATA6847 registers. The configuration registers are summarized in Table 2-5. Detailed 
information is available in the datasheet. An example of waveforms SPI communication 
is shown in Figure 2-8.

FIGURE 2-8: SPI Registers Configuration - Waveform Example.

Note: The following project options may need to be changed for the computer 
used to build the firmware:

• Add Library libdsp-elf.a located in the XC16  ???\src\Libdsp\lib 
directory.

• Add XC16-as ASM. Include Directory in XC16 ???\src\Libdsp\asm.

• Set hardware tool to “PICkit 3”, “PICkit 4”, “PICkit 5” or “REAL ICE”. 
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2.3.7 ATA6847 Message Responses

When a fault event has occurred, depending on the desired protections that have been 
enabled, the driver generates an interrupt to the host controller by pulling down the 
NIRQ line. At this moment, the host should initiate the SPI communication to read the 
status registers (DSR1, 2) and the system interrupt registers (SIR1...5) and to find out 
the fault cause. Table 2-6 summarizes the registers that should be read.
.

TABLE 2-5: CONFIGURATION MESSAGE COMMANDS (XXXXXXXX = BY DEFAULT)

 Register Address Description Asserted Parameters/Modes

DOPMCR 0x01 Device Operation Mode Control Register

Deep sleep mode

Sleep mode

Standby mode (by default)

Normal mode

GOPMCR 0x03
Gate Driver Unit Operation Mode Control 

Register

GDU OFF mode

GDU Standby mode

GDU Normal mode

WUCR 0x04 Wake-up Control Register Local wake-up enable

GDUCR1 0x05 GDU Control Register 1

BEMF det. enable/disable bit 

Cross conduction enable/disable bit

TCC = 100 ns × N, N = 0 to 63

GDUCR2 0x06 GDU Control Register 2

Edge blanking time control bits

Cross conduction protection time

LSOFF, LS = 0 when GDU = Standby

HSOFF, HS = 0 when GDU = Standby

GDUCR3 0x07 GDU Control Register 3

Low side slew rate control

High side slew rate control

Low side Adaptive dead time

High side Adaptive dead time

GDUCR4 0x08 GDU Control Register 4

VGS under-voltage filter time

VGS/VG UVLO level selection

VGS UVLO detection enable/disable-bit

Complementary control enable/disable-bit

ILIMCR 0x09 Current Limitation Control Register

Current limit shutdown enable/disable-bit

Current limitation filter time

Current limits enable/disable-bit

ILIMTH 0x0A Current Limitation Threshold Register VILIM_TH = 5/3.3V/128 × DAC.

SCPCR 0x0B Short Circuit Protection Control Register

Short circuit detection threshold

Short circuit filter time

Short circuit shutdown enable/disable-bit

CSCR 0x0C Current Sensing OpAmp Control Register

CS OpAmp gain control

CS OpAmp output offset control

Enable CS OpAmp1 enable/disable-bit

Enable CS OpAmp3 enable/disable-bit

TABLE 2-6: CONFIGURATION MESSAGE RESPONSES

 Register Address Description Asserted Parameters/Modes

DSR1 0x10 Device Status Register 1

DSR2 0x11 Device Status Register 2
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2.4 SCHEMATIC FEATURES

2.4.1 Shunt Topology

The evaluation board is designed in a combined shunt configuration. Two CSAs are 
connected on two of the three phases, while the third is summing all three phases in 
single shunt configuration. See the complete shunt topology used on this board in 
A.2 “EV43F54A – Top Schematic”.

For taking maximum advantage of the part’s features, the evaluation board is 
configured as illustrated in the picture above, which summarizes the connections 
between external current sense resistors and the internal available CSAs and GDU - 
External MOSFETs bridge. In this configuration, the evaluation board offers the option 
of evaluating either a combined shunt topology or a single shunt topology. The third 
CSA can monitor the bus current so it can be used for single shunt mode or for 
limitation of the maximum motor current in FOC or Trapezoidal control mode.

Generally, the motor phases are equilibrated, so only two-phase current are required 
to be measured, while the third will be the algebraic sum of the other two. This gives 
the possibility to use the third CSA to evaluate the current pulses across the summing 
shunt. The main advantage is that these pulses are only in positive range related to the 
initial offset and could be directed to the internal current limit comparator, without any 
particular software/hardware processing.

FIGURE 2-9: CSA's Outputs in Combined Shunts Topology.

Finally, by applying the particular procedure for currents reconstruction, the evaluation 
board offers the possibility to develop and evaluate the single shunt configuration with 
ATA6847 motor driver.

SIR1 0x13 System Interrupt Register 1

SIR2 0x14 System Interrupt Register 2

SIR3 0x15 System Interrupt Register 3

SIR4 0x16 System Interrupt Register 4

SIR5 0x17 System Interrupt Register 5

TABLE 2-6: CONFIGURATION MESSAGE RESPONSES (CONTINUED)

 Register Address Description Asserted Parameters/Modes
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2.4.2 Asymmetric Turn On/Off External MOSFET Bridge

The evaluation board offers an additional feature, to configure an asymmetric on/off for 
both H/L side external MOSFET bridge by populating R11+D9 and R15+D10 groups 
for all three phases, in order to achieve a slowdown commutation and high tight of the 
MOSFET gates to the lowest potential. Furthermore, the part could be configured to 
sink/surge 25%/50%/75% or 100% slew rate speed for LS and HS independently.

FIGURE 2-10: Optional Asymmetric Turn On-Off.

2.4.3 Current Sense Amplifier (CSA)

In order to avoid CSA output limitation and ensure the ADC range conversion, the initial 
offset of CSA is set to approximately 1.65V. The total gain of the CSA is Gt = 16. For 
high motor currents it is necessary to decrease the equivalent shunt resistor value. This 
reduces the losses and avoids analog limitation or overflows in numerical computation. 
For sense current detection, the available internal operational amplifiers are configured 
as presented in Figure 2-11 and Figure 2-12, for a high-speed and robust operation of 
the CSA.

FIGURE 2-11: Current Sense Amplifier from ATA6847.
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FIGURE 2-12: Current Sense Amplifier from dsPIC33CK.
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NOTES:
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 QFN40 BLDC MOTOR DRIVER

 EVALUATION BOARD

 USER’S GUIDE

Appendix A. Schematics and Layouts
A.1 INTRODUCTION

This appendix contains the schematics and layouts of the ATA6847 QFN40 BLDC 
Motor Driver Evaluation Board:

• EV43F54A – Top Schematic

• EV43F54A – ATA6847

• EV43F54A – dsPIC Connections

• EV43F54A – Hall Effect Sensors Connection

• EV43F54A – Inverter

• EV43F54A – Buck Converter

• EV43F54A – USB-UART Converter

• EV43F54A – Power Supply

• EV43F54A – Power Supply Divider

• EV43F54A – Push Buttons

• EV43F54A – Speed Potentiometer

• EV43F54A – Top Silk

• EV43F54A – Top Copper and Silk

• EV43F54A – Top Copper

• EV43F54A – Bottom Copper

• EV43F54A – Bottom Copper and Silk

• EV43F54A – Bottom Silk
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A.4 EV43F54A – DSPIC CONNECTIONS
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Schematics and Layouts
A.7 EV43F54A – BUCK CONVERTER

A.8 EV43F54A – USB-UART CONVERTER
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A.9 EV43F54A – POWER SUPPLY

A.10 EV43F54A – POWER SUPPLY DIVIDER
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Schematics and Layouts
A.11 EV43F54A – PUSH BUTTONS

A.12 EV43F54A – SPEED POTENTIOMETER
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A.13 EV43F54A – TOP SILK

A.14 EV43F54A – TOP COPPER AND SILK
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Schematics and Layouts
A.15 EV43F54A – TOP COPPER

A.16 EV43F54A – BOTTOM COPPER
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A.17 EV43F54A – BOTTOM COPPER AND SILK

A.18 EV43F54A – BOTTOM SILK
DS50003756B-page 38  2024 Microchip Technology Inc. and its subsidiaries



ATA6847
 QFN40 BLDC MOTOR DRIVER

 EVALUATION BOARD
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Appendix B. Bill of Materials (BOM)
TABLE B-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

3 C1, C2, C3 Capacitor, ceramic, 0.022 μF, 
25V, 10%, X7R, SMD, 0603

AVX Corporation 06033C223KAT2A

1 C4 Capacitor, ceramic, 2.2 μF, 50V, 
10%, X7R, SMD, 1206

TDK Corporation CGA5L3X7R1H225K160AB

4 C5, C6, C9, C10 Capacitor, ceramic, 2.2 μF, 10V, 
10%, X7R, SMD, 0603

Taiyo Yuden Co., Ltd. LMK107B7225KA-T

1 C7 Capacitor, ceramic, 2.2 μF, 100V, 
10%, X7R, SMD, 1210

KEMET C1210C225K1RACTU

1 C8 Capacitor, ceramic, 0.1 μF, 100V, 
10%, X7R, SMD, 0805

AVX Corporation 08051C104K4T2A

3 C11, C17, C19 Capacitor, ceramic, 1 μF, 50V, 
10%, X7R, SMD, 0805

Samsung 
Electro-Mechanics 
America, Inc.

CL21B105KBFNNNE

1 C12 Capacitor, ceramic, 4.7 μF, 16V, 
10%, X7R, SMD, 0805

Murata Electronics GRM21BR71C475KE51L

3 C13, C16, C21 Capacitor, ceramic, 0.1 μF, 25V, 
20%, X7R, SMD, 0603

KEMET C0603C104M3RACTU

1 C14 Capacitor, ceramic, 3.3 μF, 25V, 
10%, X7R, SMD, 0805

TDK Corporation C2012X7R1E335K125AB

2 C15, C20 Capacitor, ceramic, 0.22 μF, 50V, 
10%, X7R, SMD, 0805

Murata GCM21BR71H224KA37L

1 C18 Capacitor, ceramic, 0.1 μF, 50V, 
10%, X7R, SMD, 0805

Yageo Corporation 08052R104K9B20D

1 C22 Capacitor, ceramic, 1 μF, 100V, 
20%, X7S, SMD, 0805

TDK Corporation C2012X7S2A105M125AB

1 C23 Capacitor, ceramic, 0.01 μF, 25V, 
10%, X7R, SMD, 0603

Kyocera AVX® 06033C103KAT2A

1 C24 Capacitor, ceramic, 820 pF, 50V, 
10%, X7R, SMD, 0603

Yageo Corporation CC0603KRX7R9BB821

4 C25, C29, C30, C32 Capacitor, ceramic, 1500 pF, 
50V, 10%, X7R, SMD, 0603

Yageo Corporation CC0603KRX7R9BB152

1 C26 Capacitor, ceramic, 0.1 μF, 25V, 
20%, Y5V, SMD, 0603

Samsung 
Electro-Mechanics 
America, Inc.

CL10F104ZA8NNNC

1 C27 Capacitor, ceramic, 360 pF, 50V, 
5%, NP0, SMD, 0402

Murata Electronics 
North America

GRM1555C1H361JA01D

2 C28, C31 Capacitor, ceramic, 22 pF, 50V, 
5%, NP0, SMD, 0603

Yageo Corporation CC0603JRNP09BN220

2 C33, C34 Capacitor, ceramic, 0.1 μF, 25V, 
10%, X7R, SMD, 0603

AVX Corporation 06033C104KAT2A

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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2 C35, C36 Capacitor, ceramic, 0.018 μF, 
16V, 10%, X7R, SMD, 0603

KEMET C0603C183K4RAC7867

1 C37 Capacitor, ceramic, 0.1 μF, 16V, 
10%, X7R, SMD, 0603

Taiyo Yuden Co., Ltd. EMK107B7104KA-T

2 C38, C39 Capacitor, ceramic, 2200 pF, 
16V, 10%, X7R, SMD, 0603

AVX Corporation 0603YC222KAT2A

2 CB1, CB2 Capacitor, aluminum, 470 μF, 
50V, 20%, RAD, P5D12.5H20

United Chemi-Con EKZE500ELL471MK20S

1 D1 Diode, rectifier, BAS316, 1.25V, 
250 mA, 100V, SOD-323

NXP Semiconductors BAS316,115

3 D7, D18, D19 Diode, Zener, PZU15B,115, 15V 
310 mW, SMD, SOD-323

Nexperia PZU15B,115

1 D8 Diode, LED, yellow, 2.1V, 
30 mA,10mcd, diffuse, SMD, 
0805

Lumex 
Opto/Components 
Inc.

SML-LXT0805YW-TR

3 D14, D15, D16 Diode, rectifier, array, BAV99, 
1.25V, 200 mA, 70V, SOT-23-3

Micro Commercial 
Components (MCC)®

BAV99-TP

3 D20, D22, D26 Diode, LED, green, 2V, 30 mA, 
35mcd, clear, SMD, 0603

Lite-On®, Inc. LTST-C190KGKT

2 D21, D27 Diode, LED, amber, 2.1V, 25 mA, 
2mcd, clear, SMD, 0603

Lite-On, Inc. LTST-C190AKT

2 D23, D25 Diode, Schottky, 570 mV,1A, 
60V, SMD, SOD-123F

STMicroelectronics STPS1L60ZFY

1 D24 Diode, Zener, 7.5V, 200 mW, 
SOD-323

Diodes Incorporated® BZT52C7V5S-7-F

1 FB1 Ferrite, 600R@100 MHz, 
300 mA, SMD, 0603

Murata Electronics 
North America

BLM18AG601SN1D

1 FB2 Ferrite, 30R@100 MHz, 8.5A, 
AEC-Q200, SMD, 0805

Murata Electronics 
North America

BLM21SN300SH1D

1 J1 Connector, terminal, 5.08 mm, 
1x2, female, 12-28AWG, 16A, 
TH, R/A

On Shore 
Technology, Inc

EDZ350/2

1 J2 Connector, USB2.0, Micro-B, 
female, SMD, R/A

FCI 10118193-0001LF

3 J3, J5, J6 Connector, HDR-2.54, male, 1x6, 
gold, 5.84MH, TH, R/A

FCI 68016-106HLF

1 JM Connector, terminal, 5 mm, 1x3, 
Female, 12-30AWG, 16A, TH, 
R/A

Wurth Electronics, 
Inc.

691137710003

1 JpRst1 Connector, HDR-2.54, male, 1x2, 
Tin, 6.75MH, TH, vertical

Molex Inc 0901200122

1 L1 Fixed Inductor, 47 μH, 450 mA, 
834 mΩ

Wurth Electronik 74406032470

1 LABEL1 Label, PCBA, 18x6 mm, 
Datamatrix 
Assy#/Rev/Serial/Date

ACT Logimark AS 505462

1 PCB1 Printed Circuit Board — 04-12260-R1

1 PCBA1 PCB Assembly — 02-01196-R1

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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7 Q1, Q2, Q3, Q4, 
Q5, Q6, Q7

Transistor, FET, N-Channel, 40V, 
136A, 0.0023R, 800 mW, 
VDFN-8

Toshiba 
Semiconductor and 
Storage

TPH2R306NH1,LQ

1 Q8 Transistor, BJT, NPN, 45V, 
500 mA, 200 mW, SOT-323-3

Diodes Incorporated BC817-40W-7

1 R1 Resistor, Thick Film, 1k, 1%, 
1/10W, SMD, 0603

Vishay® Dale CRCW06031K00FKEA

2 R4, R5 Resistor, Thick Film, 4.7R, 1%, 
1/10W, SMD, 0603

Vishay Dale CRCW06034R70FNEA

1 R7 Resistor, Thick Film, 2.2R, 5%, 
1/10W, SMD, 0603

Stackpole Electronics 
Inc

RMCF0603JT2R20

2 R8, R42 Resistor, Thick Film, 2k, 1%, 
1/10W, SMD, 0603

Panasonic® - ECG ERJ-3EKF2001V

6 R10, R14, R17, 
R24, R31, R35

Resistor, Thick Film, 22R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF22R0V

6 R12, R16, R19, 
R26, R33, R38

Resistor, Thick Film, 120k, 1%, 
1/10W, SMD, 0603, AEC-Q200

Panasonic - ECG ERJ-3EKF1203V

3 R13, R21, R34 Resistor, Thick Film, 3.3R, 1%, 
1/8W, SMD, 0805

Vishay Dale CRCW08053R30FKEA

7 R2, R3, R9, R20, 
R22, R23, R66

Resistor, Thick Film, 10k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ103V

4 R27, R28, R29, R30 Resistor, Thick Film, 120R, 1%, 
1/10W, SMD, 0603

Stackpole Electronics 
Inc

RMCF0603FT120R

3 R36, R39, R40 Resistor, Thick Film, 47k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF4702V

3 R41, R43, R44 Resistor, Thick File, 10k, 1%, 
1/16W, SMD, 0603

TE Connectivity 
Passive Product

CPF0603F10KC1

1 R45 Resistor, Thick Film, 18k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ183V

2 R46, R60 Resistor, Thick Film, 12k, 1%, 
1/10W, SMD, 0603

Stackpole Electronics 
Inc

RMCF0603FT12K0

1 R47 Resistor, Thick Film, 36k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3602V

1 R48 Resistor, Thick Film, 240R 1% 
1/10W SMD 0603

Yageo Corporation RC0603FR-07240RL

1 R49 Resistor, Thick Film, 2.4k, 1%, 
1/10W, SMD 0603

Yageo Corporation RC0603FR-072K4L

5 R50, R55, R57, 
R61, R63

Resistor, Thick Film, 330R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3300V

1 R51 Resistor, Thick Film, 100k, 5%, 
1/10W, SMD, 0603 (Don't Use, 
Duplicate, Use RSMT0026)

Panasonic - ECG ERJ-3GEYJ104V

1 R52 Resistor, Thick Film, 31.6K, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3162V

1 R53 Resistor, Thick Film, 10k, 1%, 
1/10W, SMD, 0603

TE Connectivity 
Passive Product

CRG0603F10K

1 R54 Resistor, Thick Film, 0R 1/10W, 
SMD, 0603, AEC-Q200

Panasonic - ECG ERJ-3GEY0R00V

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 41



ATA6847 QFN40 BLDC Motor Driver EVB User’s Guide
4 R56, R58, R62, R64 Resistor, Thick Film, 470R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF4700V

2 R59, R65 Resistor, Thick Film, 24.9k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF2492V

1 R6.a Resistor, Thick Film, 0R, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3GSY0R00V

2 R67, R69 Resistor, Thick Film, 49.9R, 1%, 
1/10W, SMD, 0603, AEC-Q200

Vishay Dale CRCW060349R9FKEA

2 R68, R70 Resistor, Thick Film, 2.2k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GSYJ222V

3 RS1, RS2, RS3 Resistor, shunt, ME, 0.003R, 1%, 
4W, AEC-Q200, SMD, 2512

Vishay/Dale WSLF25123L000FEA

1 Rv1 Resistor, variable, 10K, 20%, TH, 
P090S

BI Technologies / TT 
Electronics

P090S-14T20BR10K

4 ST1, ST2, ST3, 
SW1

Switch, TACT, SPST, 24V, 
50 mA, KSR231GLFS, SMD, 
6X3.5 mm

TE Connectivity 
Alcoswitch Switches

147873-2

2 TP1, TP2 Connector, test point, TAB, silver, 
mini, 3.8x2.03 SMD

Keystone Electronics 5019

4 TP34, TP-1, TP-2, 
TP-39

Connector, test point, TAB, silver, 
mini, 3.8x2.03, SMD

Keystone Electronics 5019

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-2: BILL OF MATERIALS (BOM) – MICROCHIP PARTS

Qty. Reference Description Manufacturer Part Number

1 U1 Analog Motor Driver, Lite, 
QFN-40

Microchip Technology, Inc. ATA6847T-5033H/NHX

1 U2 MCU, 16-bit, 64K, TQFP-48 Microchip Technology, Inc. DSPIC33CK64MP205-I/PT

1 U3 Analog Switcher Buck 2 to 24V 
SOT-23-6

Microchip Technology, Inc. MCP16331T-E/CH

1 U4 Interface, USB, I2C, UART, 
TSSOP-14

Microchip Technology, Inc. MCP2221-I/ST

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-3: BILL OF MATERIALS (BOM) – DO NOT POPULATE PARTS

Qty. Reference Description Manufacturer Part Number

0 D9, D10, D11, D12, 
D13, D17

Diode, Schottky, 40V, 2A, 
SOD-123F

onsemi™ SS24FL

0 R4.a, R4.b, R6.b Resistor, Thick Film, 0R, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3GSY0R00V

0 R11, R15, R18, R25, 
R32, R37

Resistor, Thick Film, 10R, 1%, 
1/8W, SMD, 0805

ROHM Semiconductor MCR10EZHF10R0

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Appendix C. Software
C.1 SOFTWARE LOCATION

The application software may be downloaded from the ATA6847 webpage located on 
the Microchip website, http://www.microchip.com.

C.2 SELECTED FIRMWARE CONSTANTS AND DEFINITIONS

The desired driver application parameters can be set in “ATA6847.h” file. The driver 
registers and their specific properties are defined below.

All required configuration functions are implemented in the “ATA6847.c” file and can be 
called in the main application function after the power-up sequence.

 
//**** ATA6847 Application Limit Values settings **************************// 
#define VRefDAC         3300    // [mV] or 5000[mV] // 
#define CCPT_nS         700     // Cross conduction protection time= 0,100,..6300[nS] 
#define EGBLTime_nS     750     // Edge blanking time, 250 (default) 
#define AdTSWO_nS       250     // Ad Force time switch, 250 (default) 
#define VGSUVFLT_nS     1250    // VGS under-voltage filter time=500..7500, 2000[nS] (default) 
#define ILIMFLT_nS      1000    // Current limitation filter time=2000 (default) 
#define MOS_OCL         1890    // MOSFET Overcurrent Limit=[0..VRefDAC] [mV]   
#define SCThrVal_mV     250     // Short circuit detection threshold 125mV to 1750mV 
#define SCFLT_nS        1000    // Short circuit filter time,2000 (default) 

////////////////// Functions conversion prototype //////////////////////////// 
inline uint8_t SetCCPTime( unsigned CCPTime ); 
inline uint8_t Set_VGSUVFLT( unsigned Time_nS ); 
inline uint8_t TimeConversion( unsigned Time_ns );  
inline uint8_t SetSCThrVal( unsigned SCThrVal ); 
inline uint8_t SetCurrLim( long unsigned CurrThrVal ); 
inline uint8_t SetAd_TSWO( uint8_t Ad_TSWO_ns ); 

////////////////// Prepare registers content for writing ////////////////////// 
void ATA6847_Reg_Init(void); 

///////////////// Write command, configures register content ///////////////// 
void    ATA6847_Write_Reg( uint8_t reg_address,uint8_t reg_config ); 

///////////////// Read command, returns register content /////////////////////// 
uint8_t ATA6847_Read_Reg( uint8_t reg_address ); 

///////////////// Usefull functions //////////////////////////////////////////// 
uint8_t     ATA6847_Init_Normal_Mode( void ); 
void ATA6847_Init_Standby_Mode( void ); 
void ATA6847_Reg_Write_Init_Regs( void ); 
void ATA6847_Reg_Read_Init_Regs( void ); 
inline void ClearFaults( void ); 
inline void Fault_manage( void ); 
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Software
The implementation of the internal ATA6847 registers and bitwise definition can be 
found in the “ATA6847.h” file.

//***************************************************************************// 
//  ATA6847 registers bitwise definition 
//***************************************************************************// 

/////////////////////////////////////////////////////////////////////////////// 
#define DOPMCR  (0x01)//    // Device operation mode control register 
////////////////////////////////////////////////////////////////////////////// 
typedef  union { 
    struct{ 

uint8_t DvOpMd  :3;    // Select Device Operation Mode, Default=1 
uint8_t :3;    // Unused (read as 0) 
uint8_t VdIOOVSD:1;    // Vdd 

uint8_t RSTLVL  :1;    // Under-voltage (UVDD1 < UVDD1_UV_Set) 
    };  
    BYTE CFG; 
} tDOPMCR;

#define DOpM_DSleep 0b001   //  Deep sleep mode 
#define DOpM_Sleep  0b010   //  Sleep mode 
#define DOpM_St_By  0b100   //  Standby mode (default) 
#define DOpM_Normal 0b111   //  Normal mode   

// 76543210 
#define DOpM_Sleep_or_DSleep_MASK   0b00000100   

/////////////////////////////////////////////////////////////////////////////// 
#define LOPMCR  (0x02)    // LIN TRX operation mode control register 
////////////////////////////////////////////////////////////////////////////// 
typedef union {   
    struct { 

uint8_t LOPM :2; // Select LIN Transceiver operation modes
uint8_t :6; // Unused (read as 0) 

    };   
    BYTE CFG;
} tLOPMCR; 

#define LIN_St_By  0b01 // 2'b01  LIN Standby mode (default) 
#define LIN_Normal 0b10 // 2'b10  LIN Normal mode   

// Other    Invalid mode selection

/////////////////////////////////////////////////////////////////////////////// 
#define GOPMCR  (0x03)    // GDU operation mode control register 
/////////////////////////////////////////////////////////////////////////////// 
typedef union {  
    struct { 

uint8_t GDUOPM     :3;    // Select GDU operation modes
uint8_t :5;    // Unused (read as 0) 

    };  
    BYTE CFG; 
} tGOPMCR; 

#define GDU_OFF     0b001 // GDU OFF mode 1 (default) 
#define GDU_St_By   0b100 // GDU Standby mode     4 
#define GDU_Normal  0b111 // GDU Normal mode 7 

// Other Invalid mode selection 
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The configuration functions are called by the ATA6847_Drv_Init() function, as shown 
in following example.

//////////////// Registers content initialization ////////////////////////////// 
// In this function the registers are configured   
// with application required configuration
//////////////////////////////////////////////////////////////////////////////// 
void ATA6847_Reg_Init( void )     // Registers content initialization 
{ 
//////////////////// WatchDog-disabling ////////////// 
    ATA6847_REGS.REG_VAL.WDTRIG_CFG.WD_TRIG = 0x55;    //-- valid WWD trigger     
    ATA6847_REGS.REG_VAL.WDCR1_CFG.WDC = WGD_OFF ; //-- keep WWD off  // WGD_TOM  (default) // 
WGD_WOM 

//////////// LIN TRX operation mode control //////////// 
    ATA6847_REGS.REG_VAL.LOPMCR_CFG.LOPM     = LIN_Normal;  //LIN_St_By;// Operation mode 

 ///////////// GDU operation mode control ////////////// 
    ATA6847_REGS.REG_VAL.GOPMCR_CFG.GDUOPM   = GDU_OFF;//GDU_Normal;    // Operation mode 

///////////// Wake-up control register ////////////////////////// 
    ATA6847_REGS.REG_VAL.WUCR_CFG.LINWUE     = Active;//Inactive;//  // Operation mode 
    ATA6847_REGS.REG_VAL.WUCR_CFG.LOCWUE     = Active; // Operation mode 

//////////// GDU control register 1, Back-EMF, Cross conduction filter time  
   ATA6847_REGS.REG_VAL.GDUCR1_CFG.BEMFEN    = Inactive; 
   ATA6847_REGS.REG_VAL.GDUCR1_CFG.CCEN = Active; // cross-conduction timer and adaptive dead-
time  
   ATA6847_REGS.REG_VAL.GDUCR1_CFG.CCPT = SetCCPTime( CCPT_nS ); //  100 {nS] 

////////  Edge blanking time, Cross conduction time,/////////////   

   ATA6847_REGS.REG_VAL.GDUCR2_CFG.EGBLT     =  TimeConversion( EGBLTime_nS ); 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.TSWTO     =  SetAd_TSWO( AdTSWO_nS ); 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.LSOFF     = Active; //Inactive;  // 0, LS=TrS  or 1, LS=0 when 
GDU= Standby 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.HSOFF     = Active; //Inactive;  // 0, HS=TrS  or 1, HS=0 when 
GDU= Standby 

/////////// GDU Control Register 3, Adaptive dead-time, Slew rate 
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.ADDTHS    = AdDT_Dis ;  // Adaptive dead-time HS disabled;   
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.ADDTLS    = AdDT_Dis ;  // Adaptive dead-time LS disabled; 
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.HSSRC     = FullS_50_0; //FullSpeed;//FullS_12_5;//  Slew rate HS 
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.LSSRC     = FullSpeed;// FullS_25_0; //FullS_12_5;// Slew rate LS 

////////// GDU Control Register 4 ///////////////////////////UVVGSLVL 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.VGSUVFLT  = Set_VGSUVFLT( VGSUVFLT_nS ); 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.UVVGSLVL  = Active;   // VGS/VG under-voltage detection level 
selection(default=1) 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.UVVGSSEN  = Active;   // VGS under-voltage detection enable, 
default=1) 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.VDHOVSD   = Active; 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.COMPEN    = Inactive; // Complementary control enable, default=0 
IL+IH 
//////////// Current limitation control ///////////////////////////    
   ATA6847_REGS.REG_VAL.ILIMCR_CFG.ILIMSDEN  = Active ; 
   ATA6847_REGS.REG_VAL.ILIMCR_CFG.ILIMFLT   = TimeConversion( ILIMFLT_nS ); 
   ATA6847_REGS.REG_VAL.ILIMCR_CFG.ILIMEN    = Inactive; //Active ; 

///////// Current limitation threshold //////////////////////////   
   ATA6847_REGS.REG_VAL.ILIMTH_CFG.DAC = SetCurrLim( MOS_OCL ); 

////////////  Short circuit protection /////////////////////////    
   ATA6847_REGS.REG_VAL.SCPCR_CFG.SCTHSEL    = SetSCThrVal( SCThrVal_mV ); 
   ATA6847_REGS.REG_VAL.SCPCR_CFG.SCFLT = TimeConversion( SCFLT_nS ); 
   ATA6847_REGS.REG_VAL.SCPCR_CFG.SCSDEN     = Active ;//Inactive; // Short circuit shutdown enable 

/////////////// Current Sensing OpAmp control register /////////// 
   ATA6847_REGS.REG_VAL.CSCR_CFG.CSAxEN = CSCR_ALL_CSAX_DISABLED; 
   ATA6847_REGS.REG_VAL.CSCR_CFG.GAIN = Gain_16; // Gain=8,16,32,64 0b01     
   ATA6847_REGS.REG_VAL.CSCR_CFG.OFFSET = VRef_2 ; // VRef/2/4/8/16, 0b11
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To write the parameters in the driver, a Write SPI function will be called:

To get a specific register content, a particular read function is implemented.

//////  System Interrupt Mask Register1, activates interrupts ///// 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.OTPWM      = Active;      // Over temperature pre-warning 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.SPIFM      = Active;      // SPI failure interrupt 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.VSUVM      = Active;      // VS UV failure interrupt mask        
(VVS< VVS_UV_Set) 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.ILIMM      = Active;      // Current limitation event 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.VDHOVM     = Active;      // VDH OV failure interrupt 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.GSCM       = Active;  //Inactive// General short circuit failure 
    
//////  System Interrupt Mask Register2, activates interrupts ///// 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD1OVM    = Active;      // VDD1 overvoltage event interrupt  
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD2OVM    = Active;      // VDD2 over-voltage event interrupt 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD1UVLM   = Active;      // VDD1 IO under-voltage interrupt     
(VVDD1< VVDD1_IO_UV_Set) event interrupt mask bit 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD1UVHM   = Active;      // VDD1 under-voltage interrupt        
(VVDD1< VVDD1_UV_Set) event interrupt mask bit 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD2UVM    = Active;      // VDD2 under-voltage event interrupt  
    
//////  Init default register with default startup value ////////// 
   ATA6847_REGS.REG_VAL.RWPCR_CFG.CFG = 0x00; 
   ATA6847_REGS.REG_VAL.MLDCR_CFG.CFG = 0x00; 
    
    ////////// Test Device operation mode control  //////// 
    ATA6847_REGS.REG_VAL.DOPMCR_CFG.DvOpMd   = DOpM_Normal;//DOpM_St_By;//  Operation mode 
    ATA6847_REGS.REG_VAL.DOPMCR_CFG.RSTLVL   = Active;//Inactive;    
} 

///////////////// Write command, configures register content /////////////////// 
void ATA6847_Write_Reg( uint8_t reg_address, uint8_t reg_config ) 
{ 
    SPI_Command SPI_WORD; 
    SPI_WORD.ADDERSS = reg_address; 
    SPI_WORD.W_R = Write; 
    SPI_WORD.Reg_Config = reg_config; 
    SPI1_Exchange16bit(SPI_WORD.SPI_Command);    
} 

///////////////// Read command, returns register content /////////////////////// 
uint8_t ATA6847_Read_Reg( uint8_t reg_address ) 
{ 
    SPI_Command SPI_WORD; 
    SPI_WORD.ADDERSS    = reg_address; 
    SPI_WORD.W_R = Read; 
    SPI_WORD.Reg_Config = 0x00; 
    SPI_WORD.Reg_Config = ( uint8_t )(SPI1_Exchange16bit(SPI_WORD.SPI_Command)); 
    return SPI_WORD.Reg_Config;  
}
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C.3 BLDC USER PARAMETERS

/////***************** HURST Big************************// 
#ifdef  HURST_Big     
#define  NOMINALSPEEDINRPM  3150 
#define  MINSPEEDINRPM      550  // 500             
#define  INITIALTORQUE      1.5              // Initial torque current    
#define  POLEPAIRS          5                 // Number of pole pairs 
#define  PHASERES           ((float)0.35)     // Phase resistance in Ohms. 
#define  PHASEIND           ((float)0.00033)  // Phase inductance in Henrys 
#define  FILTERDELAY        90                // 90-(1...7) advance  
//*** Velocity Control Loop Coefficients ***** 
#define WKP         Q15(0.11751)//Q15(0.3657)// 
#define WKI         Q15(0.01025)//Q15(0.0285)// 
 
/////////////////////////////////////////////////// 
//******** Q Control Loop Coefficients ******* 
#define QKP         Q15(0.09275)//Q15(0.0975)// 
#define QKI         Q15(0.00725)//Q15(0.0095)// 
#define QKC         Q15(0.995) 
#define QOUTMAX     Q15(0.725)  
//******** D Control Loop Coefficients ******* 
#define  DKP         QKP 
#define DKI         QKI 
#define  DKC         QKC 
#define DOUTMAX     QOUTMAX 
 
#define  SMCGAIN        0.525 
#define  MAXLINEARSMC     0.475   // 
#endif     
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C.4 DSPIC33CK256MP508 PORT USAGE

C.4.1 Port's Mapping

Onboard Buttons:

BEMFs/Hall sensors:

C.4.2 A/D Mappings

#define On_Off_Set_Input()   (_TRISD11 = 1) 
#define On_Off_GetValue()    (_RD11) 
#define On_Off               !(_RD11)      //SW1 - BTN_1 
 
#define SPB_Set_Input()     (_TRISE10 = 1) 
#define SPB_GetValue()     (_RE10) 
#define SPB          !(_RE10)      //SW2 - BTN_2 

    // Halls or BEMF inputs 
#define BMF_A_SetDigitalInput()  (_TRISC6 = 1) 
#define BMF_B_SetDigitalInput()  (_TRISC7 = 1) 
#define BMF_C_SetDigitalInput()  (_TRISD10 = 1) 
 
#define HallA_SetDigitalInput()  (_TRISD5 = 1) 
#define HallB_SetDigitalInput()  (_TRISD6 = 1) 
#define HallC_SetDigitalInput()  (_TRISD7 = 1) 
 
#define HallA_GetValue()         _RD5 
#define HallB_GetValue()         _RD6 
#define HallC_GetValue()         _RD7 

/**************************************************************************** 
 * Setting the Analog/Digital Configuration SFR(s) 
 ***************************************************************************/ 
ANSELA = 0x0013; 
ANSELB = 0x009F; 
ANSELC = 0x0048; 
ANSELD = 0x0400; 
ANSELE = 0x000F; 
 
I_Bus_SetAnalogInput();// (_ANSELA0 = 1) 
I_B_SetAnalogInput()  ;// (_ANSELA4 = 1) 
I_A_SetAnalogInput()  ;// (_ANSELB2 = 1) 
V_Bus_SetAnalogInput();// (_ANSELC3 = 1) 
SpRef_SetAnalogInput();// (_ANSELC6 = 1) 
//  TempS_SetAnalogInput();// (_ANSELC6 = 1) 

 HallA_SetDigitalInput(); 
 HallB_SetDigitalInput(); 
 HallC_SetDigitalInput(); 
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C.4.3 Communications Mappings

C.4.4 Used Peripherals Mappings

/////// SPI  selection pin -> ATA6847 /////////////////// 
#define nCS_SetOutput()     (_TRISD2 = 0) 
#define nCS                 _LATD2 
#define nCS_Enable()        nCS = 0 
#define nCS_Disable()       nCS = 1    
#define SCK_Set_Output()    (_TRISD12 = 0)  
#define MISO_Set_Input()    (_TRISC4 = 1) 
#define MOSI_Set_Output()   (_TRISC5 = 0)  
////// UART1 pin selection  -> ATA6847 LIN UART ///////// 
#define RX_Set_Input()      _TRISC8 = 1 //EvBComb 
#define TX_Set_Output()     _TRISC9 = 0 

 /******************************************************** 
  * Set the PPS for used peripherals 
  *******************************************************/ 
 __builtin_write_RPCON( 0x0000 );    // unlock PPS 
 RPINR20bits.SCK1R = 0x004C;    // RD12->SPI1:SCK1OUT 
 RPOR22bits.RP76R = 0x0006;    // RD12->SPI1:SCK1OUT 
 RPOR10bits.RP53R = 0x0005;    // RC5->SPI1:SDO1 
 RPINR20bits.SDI1R = 0x0034;    // RC4->SPI1:SDI1 
 RPINR19bits.U2RXR = 0x004D;   // RD13->UART2:U2RX 
 RPOR23bits.RP78R = 0x0003;    // RD14->UART2:U2TX 
 __builtin_write_RPCON( 0x0800 );    // lock PPS 
 2024 Microchip Technology Inc. and its subsidiaries DS50003756B-page 45



Software
SOFTWARE

C.5 MPLAB® X COMPILER STARTUP

1. Start up the MPLAB® X compiler (not supplied, available on the Microchip 
website).

2. From the toolbar, select File>Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing project file named EV43F54A_ck_205.X
5. In the Projects window, right mouse-click on EV43F54A_ck_205.X and select 

Properties. The page contains the project properties. Processor, Compiler, 
Hardware and Config settings may be changed here.

6. Right mouse-click on EV43F54A_ck_205.X again and select “Make and 
Program Device”. This will compile the firmware and download it to the 
programming hardware.

7. The compiler results will be displayed in the Output window frame. Verify 
success.

C.6 MPLAB® X IDE AND PICKIT™ 3 EXERCISE

1. Start up the MPLAB® X (not supplied, available on the Microchip website).

2. From the toolbar, select File>Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing workspace directory named EV43F54A_ck_205.X or create 
a new one.

5. Connect the C Align Pin 1 of the header with the Pin 1 mark on the programmer.

6. Set the bench power supply voltage control to minimum voltage output.

7. Turn on the power supply and set the output voltage to 24V. Turn off the power 
supply.

8. Connect the bench power supply to the evaluation board. Connect +V(24V) to 
J1-2 and -V(Ground) to J1-1.

9. Turn on the power supply.

10. Right mouse-click on EV43F54A_ck_205.X in the Projects window and select 
“Make and Program Device”. This will compile the firmware and program the 
dsPIC33CK64MP205 processor.

11. The compiler results will be displayed in the Output window frame. Verify 
success.

12. Connect a Brushless DC (BLDC) motor to connector JM1 (MOTOR). Connect 
the motor phase wires to the PH_A (JM), PH_B (JM), and PH_C (JM) terminals.

13. Momentarily press the RESET switch on the evaluation board. This step is 
required to reset the dsPIC DSC device after programming.

14. Turn the SPEED adjustment fully counterclockwise. This sets the motor to the 
slowest speed.

15. Momentarily press the RUN switch to start the motor.

16. Momentarily press the RUN switch again to stop the motor.

17. Momentarily press the RUN switch again to start the motor.

18. Turn the SPEED adjustment clockwise. The motor speed should increase.

19. You may probe the different test points on the board to see the various signals 
being generated. The GLX, SHX, GHX (X = 1, 2, 3) test points will show the 
external MOSFET gate drive signals. 

20. Momentarily press the RUN switch again to stop the motor.
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C.7 MPLAB® X DMCI WINDOW EXERCISE
For debugging purposes, in MPLABX IDE there is a plugin tool available that can be 
used as following:

1. In the opened project, open the “UserParms.h” header file, find the line where the 
processor directive //#undef  DMCI_WIN (which undefines the DCMI window) 
is located. Comment that line.

2. In the EV43F54A_ck_205.c, the sections related to DMCI will become active.
3. Find the section where the desired variables are assigned to the DMCI declared 

vectors. For example, see the variables below:

4. The PICkit 3(4)(5) should be attached at the J3 evaluation board connector.

5. From the toolbar, select Debug->Debug Project. Wait for compilation and 
debugging to launch and run.

6. After successful project compilation and board programming, press the RUN 
button and increase the speed at around 80% from full scale. Stop the motor by 
pressing again the RUN button.

7. Stop the debugging by pressing the Pause button or <Ctrl+Alt+8>.

8. From the toolbar, select Tools->Embedded->DCMI-> DCMI Window.

9. In Dynamic Data View right click on each Data Source window and assign one 
of DMCI_WIN1[ ] to DMCI_WIN 4[ ] vectors for each of Data Source windows. In 
each Data Source window, the evolution of the assigned variable will appear. By 
merging all Data Source windows, all data can be displayed on the same graph, 
as illustrated below:

10. Notice that, after closing the debugging session, the board must be 
reprogrammed with the #undef DMCI_WIN line uncommented, as described 
above, in C6 section, in the desired motor control mode.

#ifdef DMCI_WIN             // For test pourposes               
    DMCI_WIN1[indx]= SMO_est.Ealpha;//AngleEst.CurrTheta;//IPh.a;// 
    DMCI_WIN2[indx]= SMO_est.Ebeta;//IPh.b;//I_Ph_Comp.qIb;// 
    DMCI_WIN3[indx]= I_Alpha_Beta.alpha;//I_ADC.c;//  
    DMCI_WIN4[indx]= I_Alpha_Beta.beta;//Sp_Ref.qValue;// 
    indx++; 
    if(!(indx<WIN_DIM)) 
    {indx=0;} 
#endif  
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